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Chapter 710

Group-Sequential
Logrank Tests (Legacy)
This procedure is the original two-sample Logrank (survival) group-sequential procedure in PASS. Power
calculations and boundaries are generated from analytic calculations (simulation is not used). This procedure
does not give any options for futility boundaries.

Introduction
This procedure uses analytic methods for sample size and power calculations for group-sequential Logrank tests.
PASS also has procedures for group-sequential Logrank tests based on simulations. The simulation procedures are
more flexible in terms of input parameters, and also allow for both significance and futility boundaries.
Clinical trials are longitudinal. They accumulate data sequentially through time. The participants cannot be
enrolled and randomized on the same day. Instead, they are enrolled as they enter the study. It may take several
years to enroll enough patients to meet sample size requirements. Because clinical trials are long term studies, it is
in the interest of both the participants and the researchers to monitor the accumulating information for early
convincing evidence of either harm or benefit. This permits early termination of the trial.
Group sequential methods allow statistical tests to be performed on accumulating data while a phase III clinical
trial is ongoing. Statistical theory and practical experience with these designs have shown that making four or five
interim analyses is almost as effective in detecting large differences between treatment groups as performing a
new analysis after each new data value. Besides saving time and resources, such a strategy can reduce the
experimental subject’s exposure to an inferior treatment and make superior treatments available sooner.
When repeated significance testing occurs on the same data, adjustments have to be made to the hypothesis
testing procedure to maintain overall significance and power levels. The landmark paper of Lan & DeMets (1983)
provided the theory behind the alpha spending function approach to group sequential testing. This paper built
upon the earlier work of Armitage, McPherson, & Rowe (1969), Pocock (1977), and O’Brien & Fleming (1979).
PASS implements the methods given in Reboussin, DeMets, Kim, & Lan (1992) to calculate the power and
sample sizes of various group sequential designs.
This module calculates sample size and power for group sequential designs used to compare two survival curves.
Other modules perform similar analyses for the comparison of means and proportions. The program allows you to
vary number and times of interim tests, type of alpha spending function, and test boundaries. It also gives you
complete flexibility in solving for power, significance level, sample size, or effect size. The results are displayed
in both numeric reports and informative graphics.

Technical Details
In many clinical trials, patients are recruited and randomized to receive a particular treatment, either experimental
or control, and then monitored until either a critical event occurs or the study is ended. The length of time the
patient is monitored until the critical event occurs is called the follow-up time. After the study is ended, the
follow-up times of the patients in the two groups are compared using the logrank test in what is often called a
survival analysis.
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When the critical event does not occur for a patient by the time the study is ended, the follow-up time is said to
have been censored. Although the actual event time is not known for this patient, it is known that the event time
will be greater than the follow-up time. Hence, some information is gleaned from these participants. Because of
this censoring, the usual tests of means or proportions cannot be used. The logrank test was developed to provide
a statistical test comparing the efficacy of the two treatments.

The Hazard Ratio (HR)
Suppose the critical event is death. The survival distribution of each treatment can be characterized by the
instantaneous death rates, λ1 and λ2 . An instantaneous death rate, often called the hazard, is the probability of
death in a short interval of time. The comparison of the efficacies of the two treatments is often formalized by
considering the ratio of the hazard, or hazard ratio (HR).

HR =

λ2
λ1

Although the logrank test concerns the ratio of the hazard rates of the two groups, when planning a study, it may
be easier to obtain information about the expected proportion surviving during the trial. It turns out that the hazard
ratio can be computed from the survival proportions, S1 and S2, using the equation

HR =

log( S 2)
log( S1)

when the hazard ratio is constant through time.
Assuming that group one is the control group, it may be easiest during the planning stages of a study to find S1
and state the minimum value of HR that would make the experimental treatment useful. The last equation can then
be manipulated to calculate a value for S2 as follows

}

{

S 2 = exp HR(log( S1)) .
Sometimes it is more convenient to state hazard ratio in terms of the median survival times. In this case, the
hazard ratio is estimated using

HR =

M1
M2

when the hazard ratio is constant for different times.

The Logrank Statistic
The following results are excerpted from Reboussin (1992). The logrank statistic is given by the equation
d
 xr 
L( d ) = ∑  i ic 
i =1  ric + rit 

where d is the number of events, xi is 1 if the event at time ti is in the control group and 0 if it is in the treatment
group, ric is the number of patients in the control group at risk just be before ti , and rit is the corresponding
number of patients at risk in the treatment group.
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If ric ≈ rit and HR is close to 1, then the sequential logrank statistic is (approximately)

zk = 2

L( d k )
.
dk

The subscript k indicates that the computations use all data that are available at the time of the kth interim analysis
or kth look (k goes from 1 to K).

Spending Functions
Lan and DeMets (1983) introduced alpha spending functions, α (τ ) , that determine a set of boundaries

b1 , b2 ,, bK for the sequence of test statistics z1 , z2 ,, z K . These boundaries are the critical values of the
sequential hypothesis tests. That is, after each interim test, the trial is continued as long as z k < bk . When
z k ≥ bk , the hypothesis of equal means is rejected, and the trial is stopped early.
The time argument τ either represents the proportion of elapsed time to the maximum duration of the trial or the
proportion of the sample that has been collected. When elapsed time is used, it is referred to as calendar time.
When time is measured in terms of the sample, it is referred to as information time. Since it is a proportion, τ can
only vary between zero and one.
Alpha spending functions have the characteristics:

α (0) = 0
α (1) = α
The last characteristic guarantees a fixed α level when the trial is complete. That is,

Pr( z1 ≥ b1 or z 2 ≥ b2 or  or z k ≥ bk ) = α (τ )
This methodology is very flexible since neither the times nor the number of analyses must be specified in
advance. Only the functional form of α (τ ) must be specified.
PASS provides five popular spending functions plus the ability to enter and analyze your own boundaries. These
are calculated as follows:

Z 
2 − 2Φ  α / 2 
 τ 

1. O’Brien-Fleming

O'Brien-Fleming Boundaries with Alpha = 0.05
5
4
3

Z Value

2
Upper

1
0
-1

1

2

3

4

5
Lower

-2
-3
-4
-5

Look
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α ln(1 + (e − 1)τ )

2. Pocock

Pocock Boundaries with Alpha = 0.05
5.0

Z Value

3.3
1.7

Upper

0.0
1

2

3

4

5

-1.7

Lower

-3.3
-5.0

Look

ατ

3. Alpha * time

(Alpha)(Time) Boundaries with Alpha = 0.05
5.0

Z Value

3.3
1.7

Upper

0.0
1

2

3

4

5

-1.7

Lower

-3.3
-5.0

Look

4. Alpha * time^1.5

ατ 3/ 2

(Alpha)(Time^1.5) Boundaries with Alpha = 0.05
5.0

Z Value

3.3
1.7

Upper

0.0
1

2

-1.7

3

4

5
Lower

-3.3
-5.0

Look
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ατ 2

5. Alpha * time^2

(Alpha)(Time^2.0) Boundaries with Alpha = 0.05
5.0

Z Value

3.3
1.7

Upper

0.0
1

3

2

4

-1.7

5
Lower

-3.3
-5.0

Look

6. User Supplied
A custom set of boundaries may be entered.
The O’Brien-Fleming boundaries are commonly used because they do not significantly increase the overall
sample size and because they are conservative early in the trial. Conservative in the sense that the means must be
extremely different before statistical significance is indicated. The Pocock boundaries are nearly equal for all
times. The Alpha*t boundaries use equal amounts of alpha when the looks are equally spaced. You can enter your
own set of boundaries using the User Supplied option.

Sequential Theory
A detailed account of the methodology is contained in Lan & DeMets (1983), DeMets & Lan (1984), Lan &
Zucker (1993), and DeMets & Lan (1994). A brief summary of the theoretical basis of the method will be
presented here.
Group sequential procedures for interim analysis are based on their equivalence to discrete boundary crossing of a
Brownian motion process with drift parameter θ . The test statistics z k follow the multivariate normal
distribution with means θ τ k and, for j ≤ k , covariances

τ k / τ j . The drift is related to the parameters of the

z-test through one of the equations

θ=

1 − HR d k
log( HR) d k
(exponential survival) or θ =
(proportional hazards).
2
(1 + HR)

These equations may be solved for d k , the required number of events, giving

dk =

 (1 + HR)θ 
(exponential survival) or d k = 
 (proportional hazards).
 1 − HR 
2

4θ 2

[log( HR)]

2

In survival analysis, the size of a sample is measured in terms of number of events rather than number of patients
because it is probable that many of the patients will be censored—their event times are not known. In order to
ensure that the sample size produces the required number of events, it must be inflated by the event rates.
The expected number of events can be computed from the proportion surviving using the equation

dk =

N (1 − S1 ) + N (1 − S 2 )
2
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where N is the total sample size (assumed to be split evenly between groups). This can be solved for N to give the
sample size as

N=

2d k
.
2 − S1 − S 2

Hence, the algorithm is as follows:
1. Compute boundary values based on a specified spending function and alpha value.
2. Calculate the drift parameter based on those boundary values and a specified power value.
3. Use the drift parameter and the above equation to calculate the appropriate event size per group d k .
4. Use the event size to compute the appropriate sample size, N.

Procedure Tabs
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains the parameters associated with the z-test such as the survival rates, sample sizes, alpha,
and power.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be
selected are S1, S2, Alpha, Power, or Sample Size. Under most situations, you will select either Power or Sample
Size.
Select Sample Size when you want to calculate the sample size needed to achieve a given power and alpha level.
Select Power and Beta when you want to calculate the power of an experiment.

Test
Alternative Hypothesis
Specify whether the test is one-sided or two-sided. When a two-sided hypothesis is selected, the value of alpha is
halved. Everything else remains the same.
Note that the accepted procedure is to use Two-Sided unless you can justify using a one-sided test.
Survival Time Assumption
Calculations can be based on the assumption of exponential survival times or proportional hazards. The
proportional hazards assumption is the less restrictive and the one that is recommended.
•

Exponential Survival
The survival curves follow exponential distributions. This is the most restrictive assumption.

•

Proportional Hazards
The hazards of the two groups are proportional.
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Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
equal survival curves when in fact the curves are different.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when you
reject the null hypothesis of equal survival curves when in fact the curves are equal.
Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means
that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that
represents the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size
N (Total Sample Size)
Enter a value (or range of values) for the total sample size. Each group is assumed to have a sample size of N/2.
You may enter a range of values such as 100 to 1000 by 100.
Note that the sample size is based implicitly on the length of the study since we used the equation

N=

2d k
2 − S1 − S 2

to estimate the necessary sample size.

Effect Size
S1 (Proportion Surviving 1)
S1 is the proportion of patients belonging to group 1 (controls) that are expected to survive during the study. Since
S1 is a proportion, it must be between zero and one. In many studies, this is the proportion surviving in the regular
population with the standard treatment.
You may enter a range of values such as 0.1, 0.2, 0.3 or 0.1 to 0.9 by 0.2.
S2 (Proportion Surviving 2)
S2 is the proportion of patients in the experimental group that survive during the study. This is not necessarily the
expected proportion. Rather, you may set it to that proportion that, if achieved, would be of special interest.
Values below (or above) this amount would not be of interest. For example, if the standard one-year survival
proportion is 0.2 and the new treatment raises this proportion to 0.3 (a 50% increase in the proportion surviving),
others may be interested in adopting this new treatment.
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Sometimes, researchers wish to state the alternative hypothesis in terms of the hazard ratio, HR, rather than the
value of S2. Using the fact that

HR =

log( S 2)
,
log( S1)

An appropriate value for S2 may be calculated from S1 and HR using the equation

{

}

S 2 = exp HR(log( S1)) .
Sometimes it is more convenient to state hazard ratio in terms of the median survival times. In this case, the
hazard ratio is estimated using

HR =

M1
M2

and the above equation is used to find S2.
Since S2 is a proportion, it must remain between zero and one. You may enter a range of values such as 0.1, 0.2,
0.3 or 0.1 to 0.9 by 0.2.

Look Details
The Sequential tab contains the parameters associated with Group Sequential Design such as the type of spending
function, the times, and so on.
Number of Looks
This is the number of interim analyses (including the final analysis). For example, a five here means that four
interim analyses will be run in addition to the final analysis.
Boundary Truncation
You can truncate the boundary values at a specified value. For example, you might decide that no boundaries
should be larger than 4.0. If you want to implement a boundary limit, enter the value here.
If you do not want a boundary limit, enter None here.
Spending Function
Specify which alpha spending function to use. The most popular is the O'Brien-Fleming boundary that makes
early tests very conservative. Select User Specified if you want to enter your own set of boundaries.
Max Time
This is the total running time of the trial. It is used to convert the values in the Times box to fractions. The units
(months or years) do not matter, as long as they are consistent with those entered in the Times box.
For example, suppose Max Time = 3 and Times = 1, 2, 3. Interim analyses would be assumed to have occurred at
0.33, 0.67, and 1.00.
Times
Enter a list of time values here at which the interim analyses will occur. These values are scaled according to the
value of the Max Time option.
For example, suppose a 48-month trial calls for interim analyses at 12, 24, 36, and 48 months. You could set Max
Time to 48 and enter 12,24,36,48 here or you could set Max Time to 1.0 and enter 0.25,0.50,0.75,1.00 here.
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The number of times entered here must match the value of the Number of Looks.
•

Equally Spaced
If you are planning to conduct the interim analyses at equally spaced points in time, you can enter Equally
Spaced and the program will generate the appropriate time values for you.

Informations
You can weight the interim analyses on the amount of information obtained at each time point rather than on
actual calendar time. If you would like to do this, enter the information amounts here. Usually, these values are
the sample sizes obtained up to the time of the analysis.
For example, you might enter 50, 76, 103, 150 to indicate that 50 individuals where included in the first interim
analysis, 76 in the second, and so on.
Upper and Lower Boundaries (Spending = User)
If the Spending Function is set to User Supplied you can enter a set of lower test boundaries, one for each interim
analysis. The lower boundaries should be negative and the upper boundaries should be positive. Typical entries
are 4,3,3,3,2 and 4,3,2,2,2.
•

Symmetric
If you only want to enter the upper boundaries and have them copied with a change in sign to the lower
boundaries, enter Symmetric for the lower boundaries.

Options Tab
The Options tab controls the convergence of the various iterative algorithms used in the calculations.

Maximum Iterations
Maximum Iterations (Lan-Demets algorithm)
This is the maximum number of iterations used in the Lan-DeMets algorithm during its search routine. We
recommend a value of at least 200.

Tolerance
Probability Tolerance
During the calculation of the probabilities associated with a set of boundary values, probabilities less than this are
assumed to be zero.
We suggest a value of 0.00000000001.
Power Tolerance
This is the convergence level for the search for the spending function values that achieve a certain power. Once
the iteration changes are less than this amount, convergence is assumed. We suggest a value of 0.0000001.
If the search is too time consuming, you might try increasing this value.
Alpha Tolerance
This is the convergence level for the search for a given alpha value. Once the changes in the computed alpha
value are less than this amount, convergence is assumed and iterations stop. We suggest a value of 0.0001.
This option is only used when you are searching for alpha.
If the search is too time consuming, you may try increasing this value.
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Example 1 – Finding the Sample Size
A clinical trial is to be conducted over a two-year period to compare the hazard rate of a new treatment to that of
the current treatment. The proportion surviving for two years using the current treatment is 0.3. The health
community will be interested in the new treatment if the proportion surviving is increased to 0.45, a 50% increase.
So that the sample size requirements for several survival proportions can be compared, it is also of interest to
compute the sample size at response rates of 0.30, 0.35, 0.40, and 0.50. Assume the survival times are
exponential.
Testing will be done at the 0.05 significance level and the power should be set to 0.10. A total of four tests are
going to be performed on the data as they are obtained. The O’Brien-Fleming boundaries will be used.
Find the necessary sample sizes and test boundaries assuming equal sample sizes for each arm and two-sided
hypothesis tests.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may then make the appropriate entries as listed below, or open
Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ Two-Sided
Survival Time Assumption ...................... Exponential Survival
Power ...................................................... 0.90
Alpha ....................................................... 0.05
S1 (Proportion Surviving 1) .................... 0.3
S2 (Proportion Surviving 2) .................... 0.35 0.40 0.45 0.50
Number of Looks .................................... 4
Spending Function .................................. O’Brien-Fleming
Boundary Truncation .............................. None
Max Time ................................................ 2
Times ...................................................... Equally Spaced
Informations ............................................ Blank

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Two-Sided LogRank Test (Assuming Exponential Survival)
Total
Sample
Power Size (N)
0.900003 3378
0.900267
884
0.900626
407
0.900018
234

Total
Required
Events
2280
575
254
140

Alpha
0.050000
0.050000
0.050000
0.050000

Proportion
Beta Surv. (S1)
0.099997
0.3000
0.099733
0.3000
0.099374
0.3000
0.099982
0.3000

Proportion
Surv. (S2)
0.3500
0.4000
0.4500
0.5000

Hazard
Ratio
0.8720
0.7611
0.6632
0.5757
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Report Definitions
Power is the probability of rejecting a false null hypothesis. Power should be close to one.
N is the number of items sampled from each group.
Events is the number of events that must occur in each group.
Alpha is the probability of rejecting a true null hypothesis in at least one of the sequential tests.
Beta is the probability of accepting a false null hypothesis at the conclusion of all tests.
S1 is the proportion surviving in group 1.
S2 is the proportion surviving in group 2.
HR is the hazard ratio. It is calculated using Log(S2)/Log(S1).
Summary Statements
A total sample size of 3378 (split equally between the two groups), or 2280 events, achieves
90% power to detect a hazard rate of 0.8720 when the proportions surviving in each group are
0.3000 and 0.3500 at a significance level (alpha) of 0.050000 using a two-sided log rank test.
These results assume that 4 sequential tests are made using the O'Brien-Fleming spending
function to determine the test boundaries and that the survival times are exponential.

This report shows the values of each of the parameters, one scenario per row. Note that 254 events are required
when S2 = 0.45. Based on the expected survival proportions, this many events will occur if the overall sample size
is 407.
Total Sample Size (N)
This is the estimated sample size that is needed to obtain the necessary number of events.
Total Required Events
This is the number of events (deaths, etc.) that are required to achieve the desired power levels.

Plots Section

This plot shows that an increase in sample size from under 1000 to well over 3000 is necessary when the
detectable proportion surviving is reduced from 0.4 to 0.35.
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Details Section
Details when Spending = O'Brien-Fleming, N = 407, d = 254, S1 = 0.3000, S2 = 0.4500
Lower
Upper
Nominal
Inc
Total
Inc
Look Time
Bndry
Bndry
Alpha
Alpha
Alpha
Power
1
0.5000
-4.33263
4.33263 0.000015 0.000015 0.000015 0.003516
2
1.0000
-2.96311
2.96311 0.003045 0.003036 0.003051 0.255183
3
1.5000
-2.35902
2.35902 0.018323 0.016248 0.019299 0.427665
4
2.0000
-2.01406
2.01406 0.044003 0.030701 0.050000 0.214262
Drift 3.27466

Total
Power
0.003516
0.258699
0.686364
0.900626

This report shows information about the individual interim tests. One report is generated for each scenario.
Look
These are the sequence numbers of the interim tests.
Time
These are the time points at which the interim tests are conducted. Since the Max Time was set to 2 (for two
years), these time values are in years. Hence, the first interim test is at half a year, the second at one year, and so
on.
We could have set Max Time to 24 so that the time scale was in months.
Lower and Upper Boundary
These are the test boundaries. If the computed value of the test statistic z is between these values, the trial should
continue. Otherwise, the trial can be stopped.
Nominal Alpha
This is the value of alpha for these boundaries if they were used for a single, standalone, test. Hence, this is the
significance level that must be found for this look in a standard statistical package that does not adjust for multiple
looks.
Inc Alpha
This is the amount of alpha that is spent by this interim test. It is close to, but not equal to, the value of alpha that
would be achieved if only a single test was conducted. For example, if we lookup the third value, 2.35902, in
normal probability tables, we find that this corresponds to a (two-sided) alpha of 0.018323. However, the entry is
0.016248. The difference is due to the correction that must be made for multiple tests.
Total Alpha
This is the total amount of alpha that is used up to and including the current test.
Inc Power
These are the amounts that are added to the total power at each interim test. They are often called the exit
probabilities because they give the probability that significance is found and the trial is stopped, given the
alternative hypothesis.
Total Power
These are the cumulative power values. They are also the cumulative exit probabilities. That is, they are the
probability that the trial is stopped at or before the corresponding time.
Drift
This is the value of the Brownian motion drift parameter.
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Boundary Plots

This plot shows the interim boundaries for each look. This plot shows very dramatically that the results must be
extremely significant at early looks, but that they are near the single test boundary (1.96 and -1.96) at the last
look.
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Example 2 – Finding the Power
Continuing the scenario began in Example1, the researcher wishes to calculate the power of the design at sample
sizes 50, 250, 450, 650, and 850. Testing will be done at the 0.01, 0.05, 0.10 significance levels and the overall
power will be set to 0.10. Find the power of these sample sizes and test boundaries assuming equal sample sizes
per arm and two-sided hypothesis tests.
Proceeding as in Example1, we decide to translate the mean and standard deviation into a percent of mean scale.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may then make the appropriate entries as listed below, or open
Example 2 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alternative Hypothesis ............................ Two-Sided
Survival Time Assumption ...................... Exponential Survival
Alpha ....................................................... 0.01 0.05 0.10
N (Total Sample Size)............................. 50 to 850 by 200
S1 (Proportion Surviving 1) .................... 0.3
S2 (Proportion Surviving 2) .................... 0.45
Number of Looks .................................... 4
Spending Function .................................. O’Brien-Fleming
Boundary Truncation .............................. None
Max Time ................................................ 2
Times ...................................................... Equally Spaced
Informations ............................................ Blank

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Two-Sided LogRank Test (Assuming Exponential Survival)
Total
Sample
Power Size (N)
0.075632
50
0.491011
250
0.802921
450
0.938923
650
0.983780
850
0.205032
50
0.719225
250
0.926894
450
(report continues)

Total
Required
Events
31
156
281
406
531
31
156
281

Alpha
0.010000
0.010000
0.010000
0.010000
0.010000
0.050000
0.050000
0.050000

Proportion
Beta Surv. (S1)
0.924368
0.3000
0.508989
0.3000
0.197079
0.3000
0.061077
0.3000
0.016220
0.3000
0.794968
0.3000
0.280775
0.3000
0.073106
0.3000

Proportion
Surv. (S2)
0.4500
0.4500
0.4500
0.4500
0.4500
0.4500
0.4500
0.4500

Hazard
Ratio
0.6632
0.6632
0.6632
0.6632
0.6632
0.6632
0.6632
0.6632
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These data show the power for various sample sizes and alphas. It is interesting to note that once the sample size
is greater than about 450, the value of alpha has comparatively little difference on the value of power.

710-15
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Group-Sequential Logrank Tests (Legacy)

Example 3 – Effect of Number of Looks
Continuing with examples one and two, it is interesting to determine the impact of the number of looks on power.
PASS allows only one value for the Number of Looks parameter per run, so it will be necessary to run several
analyses. To conduct this study, set alpha to 0.05, N to 407, and leave the other parameters as before. Run the
analysis with Number of Looks equal to 1, 2, 3, 4, 6, 8, 10, and 20. Record the power for each run.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may then make the appropriate entries as listed below, or open
Example 3 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alternative Hypothesis ............................ Two-Sided
Survival Time Assumption ...................... Exponential Survival
Alpha ....................................................... 0.05
N (Total Sample Size)............................. 407
S1 (Proportion Surviving 1) .................... 0.3
S2 (Proportion Surviving 2) .................... 0.45
Number of Looks .................................... 1 (Also run with 2, 3, 4, 6, 8, 10, and 20)
Spending Function .................................. O’Brien-Fleming
Boundary Truncation .............................. None
Max Time ................................................ 2
Times ...................................................... Equally Spaced
Informations ............................................ Blank

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Two-Sided Logrank Test (Assuming Exponential Survival)
Power
0.905693
0.904719
0.902412
0.900626
0.898243
0.896763
0.895758
0.893398

N
407
407
407
407
407
407
407
407

Events
254
254
254
254
254
254
254
254

Alpha
0.050000
0.050000
0.050000
0.050000
0.050000
0.050000
0.050001
0.050001

Beta
0.094307
0.095281
0.097588
0.099374
0.101757
0.103237
0.104242
0.106602

S1
0.3000
0.3000
0.3000
0.3000
0.3000
0.3000
0.3000
0.3000

S2
0.4500
0.4500
0.4500
0.4500
0.4500
0.4500
0.4500
0.4500

Looks
1
2
3
4
6
8
10
20

This analysis shows how little the number of looks impacts the power of the design. The power of a study with no
interim looks is 0.905693. When twenty interim looks are made, the power falls to 0.893398—a very small
change.
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Example 4 – Studying a Boundary Set
Continuing with the previous examples, suppose that you are presented with a set of boundaries and want to find
the quality of the design (as measured by alpha and power). This is easy to do with PASS. Suppose that the
analysis is to be run with five interim looks at equally spaced time points. The upper boundaries to be studied are
3.5, 3.5, 3.0, 2.5, 2.0. The lower boundaries are symmetric. The analysis would be run as follows.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may then make the appropriate entries as listed below, or open
Example 4 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alternative Hypothesis ............................ Two-Sided
Survival Time Assumption ...................... Exponential Survival
Alpha ....................................................... 0.05 (will be calculated from boundaries)
N (Total Sample Size)............................. 407
S1 (Proportion Surviving 1) .................... 0.30
S2 (Proportion Surviving 2) .................... 0.45
Number of Looks .................................... 5
Spending Function .................................. User Supplied
Boundary Truncation .............................. None
Max Time ................................................ 2
Times ...................................................... Equally Spaced
Informations ............................................ Blank
Upper Boundaries ................................... 3.5 3.5 3.0 2.5 2.0
Lower Boundaries ................................... Symmetric

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results for Two-Sided Logrank Test (Assuming Exponential Survival)
Total
Sample
Power Size (N)
0.900747
407

Total
Required
Events
254

Alpha
0.048157

Proportion
Beta Surv. (S1)
0.099253
0.3000

Proportion
Surv. (S2)
0.4500

Hazard
Ratio
0.6632

Details when Spending = User Supplied, N = 407, d=254, S1 = 0.3000, S2 = 0.4500
Lower
Upper
Nominal
Inc
Total
Inc
Look Time
Bndry
Bndry
Alpha
Alpha
Alpha
Power
1
0.4000
-3.50000
3.50000 0.000465 0.000465 0.000465 0.020899
2
0.8000
-3.50000
3.50000 0.000465 0.000408 0.000874 0.063132
3
1.2000
-3.00000
3.00000 0.002700 0.002410 0.003284 0.243522
4
1.6000
-2.50000
2.50000 0.012419 0.010331 0.013615 0.343072
5
2.0000
-2.00000
2.00000 0.045500 0.034542 0.048157 0.230122
Drift 3.27466

Total
Power
0.020899
0.084031
0.327553
0.670625
0.900747

The power for this design is about 0.90. This value depends on both the boundaries and the sample size. The alpha
level is about 0.048. This value only depends on the boundaries.
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Example 5 – Validation using O’Brien-Fleming Boundaries
Reboussin (1992) presents an example for binomial distributed data for a design with two-sided O’Brien-Fleming
boundaries, looks = 3, alpha = 0.05, beta = 0.10, S1 = 0.30, S2 = 0.786 (which gives a hazard ratio of 0.20). They
compute a drift of 3.261 and the number of events at 16.42. The upper boundaries are: 4.8769, 3.3569, 2.6803,
2.2898, 2.0310.
To test that PASS provides the same result, enter the following.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may then make the appropriate entries as listed below, or open
Example 5 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ Two-Sided
Survival Time Assumption ...................... Exponential Survival
Power ...................................................... 0.90
Alpha ....................................................... 0.05
S1 (Proportion Surviving 1) .................... 0.30
S2 (Proportion Surviving 2) .................... 0.786
Number of Looks .................................... 5
Spending Function .................................. O’Brien-Fleming
Boundary Truncation .............................. None
Max Time ................................................ 1
Times ...................................................... Equally Spaced
Informations ............................................ Blank

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Two-Sided Logrank Test (Assuming Exponential Survival)
Total
Sample
Power Size (N)
0.905173
37

Total
Required
Events
17

Alpha
0.050000

Proportion
Beta Surv. (S1)
0.094827
0.3000

Proportion
Surv. (S2)
0.7860

Hazard
Ratio
0.2000

Details when Spending = O'Brien-Fleming, N = 37, d = 17, S1 = 0.3000, S2 = 0.7860
Lower
Upper
Nominal
Inc
Total
Inc
Look Time
Bndry
Bndry
Alpha
Alpha
Alpha
Power
1
0.2000
-4.87688
4.87688 0.000001 0.000001 0.000001 0.000341
2
0.4000
-3.35695
3.35695 0.000788 0.000787 0.000788 0.102760
3
0.6000
-2.68026
2.68026 0.007357 0.006828 0.007616 0.352450
4
0.8000
-2.28979
2.28979 0.022034 0.016807 0.024424 0.298953
5
1.0000
-2.03100
2.03100 0.042255 0.025576 0.050000 0.150669
Drift 3.30902

Total
Power
0.000341
0.103101
0.455551
0.754504
0.905173

The number of events, rounded to 17, matches the 16.42 reported in Reboussin (1992).
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